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Chapter 549

Tests for Multiple
Poisson Rates in a OneWay Design
Introduction
This module calculates the power and sample size for count data from a one-way design for testing for differences
among means of those groups. This is analogous to the classical one-way ANOVA design that is used to analyze
means of normal outcomes. In the case of only two groups, this procedure produces power and sample size
estimates that match those from the two independent-group Poisson means procedure.
The methods used in this chapter come from Mai and Zhang (2017). They proposed using a likelihood ratio test
that has similar power characteristics to Poisson regression.

Technical Details
Test Statistic
Technical details are given in Mai and Zhang (2017).
Suppose we have Ng (g = 1, …, G) subjects in each of G groups for a total of N subjects. Let 𝑌𝑌𝑔𝑔𝑔𝑔 be the count
response (0, 1, 2, …) of subject j in group g. The response is modeled by the model 𝑌𝑌𝑔𝑔𝑔𝑔 ~𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃�𝜇𝜇𝑔𝑔 �.
The log-likelihood ratio test statistic

𝐺𝐺

� = −2 � 𝑁𝑁𝑔𝑔 �𝑦𝑦�𝑔𝑔 �ln(𝑦𝑦�) − ln�𝑦𝑦�𝑔𝑔 � + �𝑦𝑦�𝑔𝑔 − 𝑦𝑦����
𝐷𝐷
𝑔𝑔=1

where 𝑦𝑦� is the overall mean of Y and 𝑦𝑦�𝑔𝑔 is the mean of Y in group g.

Under the null hypothesis of equal means, this test statistic follows the chi-squared distribution with G – 1 degrees
of freedom.
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Effect Size
Cramer’s V is used as a standardized effect size measure. It gives the association between the count outcome
variable and the group variable as a proportion of the maximum possible variation.
The definition of the effect size is
2

𝐺𝐺

𝑉𝑉 = −2 �

𝑔𝑔=1

𝑁𝑁𝑔𝑔
�𝜇𝜇 �ln(𝜇𝜇0 ) − ln�𝜇𝜇𝑔𝑔 �� + �𝜇𝜇𝑔𝑔 − 𝜇𝜇0 ��
𝑁𝑁(𝐺𝐺 − 1) 𝑔𝑔

where 𝜇𝜇g is the mean for group g and 𝜇𝜇0 is the overall mean of all groups.
The sample effect size is estimated by

�
𝐷𝐷
𝑉𝑉� = �
𝑁𝑁(𝐺𝐺 − 1)

Power
The power of this test is given by
power = 𝑃𝑃𝑃𝑃{𝐷𝐷 ≥ 𝐶𝐶|𝐻𝐻1 }
= 𝑃𝑃𝑃𝑃{𝜒𝜒 2 (𝑑𝑑𝑑𝑑, 𝛿𝛿) ≥ 𝐶𝐶}
= 1 − Ψdf,δ (𝐶𝐶)
2 (𝐺𝐺
= 1 − ΨG−1,N(G−1)V2 [𝜒𝜒1−𝛼𝛼
− 1)]

where Ψdf,δ is a cumulative distribution function of a noncentral chi-squared random variable with df degrees of
freedom and noncentrality 𝛿𝛿 and C is the critical value from a central chi-squared distribution with degrees of
freedom G – 1 and significance level 1 − 𝛼𝛼.

Sample Size
The above power formula can be used in a binary search to obtain an appropriate value for the sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program
searches for the lowest sample size that meets the alpha and power criterion you have specified. The Solve For
parameter is displayed on the vertical axis of the plot.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size and Group Allocation
G (Number of Groups)
This is the number of groups (arms) whose means are being compared. The number of items used in the Group
Allocation boxes is controlled by this number.
Range
G ≥ 2.
Group Allocation Input Type (when Solve For = Power)
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.
Possible options are:
•

Equal (N1 = N2 = ... = NG)
The sample size of every group is Ni. All group sample sizes are equal. Enter one or more values for Ni.

•

Enter group multipliers
Enter a list of group multipliers (r1, r2, ..., rG) and one or more values of Ni. The individual group sample
sizes are found by multiplying the multipliers by Ni. For example, N1 = r1 x Ni.

•

Enter N1, N2, …, NG
Enter a list of group sample sizes, one for each group.

•

Enter columns of Ni's
Select one or more columns of the spreadsheet that each contain a set of group sample sizes going down the
column. Each column is analyzed separately.
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Ni (Sample Size Per Group)
Enter Ni, the number of subjects in each group. The total number of subjects, N, is equal to Ni x (number of
groups).
You can specify a single value or a list.
Single Value
Enter a value for the sample size of all groups. If you enter ‘10’ here and there are five groups, then each group
will be assigned 10 subjects and the total sample size will be 50.
List of Values
A separate power analysis is calculated for each value of n in the list. All analyses assume that the common,
group sample size is Ni.
Range of Ni
Ni > 1
Group Multipliers (r1, r2, …, rG)
Enter a set of G multipliers, one for each group.
The individual group sample sizes is computed as Ni = ceiling[ri x N], where ceiling[y] is the first integer greater
than or equal to y. For example, the multipliers {1, 1, 2, 2.95} and base Ni of 10 would result in the sample sizes
{10, 10, 20, 30}.
Incomplete List
If the number of items in the list is less than G, the missing multipliers are set equal to the last entry in the list.
Range
The items in the list must be positive. The resulting sample sizes must be at least 1.
Ni (Base Sample Size Per Group)
Enter Ni, the base number of subjects in each group. The number of subjects in the group is found by multiplying
this number by the corresponding group multiplier, {r1, r2, ..., rG}, and rounding up to the next integer.
You can specify a single value or a list.
Single Value
Enter a value for the base group sample size.
List of Values
A separate power analysis is calculated for each value of Ni in the list.
Range
Ceiling[N x ri] ≥ 1.
N1, N2, …, NG (List)
Enter a list of G sample sizes, one for each group.
Incomplete List
If the number of items in the list is less than G, the missing sample sizes are set equal to the last entry in the list.
Range
The items in the list must be positive. At least one item in the list must be greater than 1.
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Columns of Ni’s
Enter one or more spreadsheet columns containing vertical lists of group sample sizes.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the group sample sizes are entered going down.
Examples (assuming G = 3)
C1
C2
C3
111
1
28
115
20
68
100
30
46
Definition of a Single Column
Each column gives one list. Each column results in a new scenario. The columns are not connected, but all should
have exactly G rows.
Each entry in the list is the sample size of that group.
Incomplete List
If the number of items in the list is less than G, the missing entries are set equal to the last entry in the list.
Valid Entries
All values should be positive integers. At least one value must be greater than one.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.
Group Allocation Input Type (when Solve For = Sample Size)
Specify how you want to enter the information about how the subjects are allocated to each of the G groups.
Options
•

Equal (N1 = N2 = ... = NG)
All group sample sizes are equal to Ni. The value of Ni will be found by conducting a search.

•

Enter group allocation pattern
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be
rescaled into proportions by dividing each item by the sum of all items. The individual group sample sizes are
found by multiplying these proportions by N (the total sample size) and rounding up.

•

Enter columns of allocation patterns
Select one or more columns of the spreadsheet that each contain a group allocation pattern going down the
column. Each column is analyzed separately.

Group Allocation Pattern (r1, r2, …, rG)
Enter an allocation pattern (r1, r2, ..., rG). The pattern consists of a set of G numbers. These numbers will be
rescaled into proportions of total sample size by dividing each item by the sum of all items. The individual group
sample sizes are found by multiplying these proportions by N (the total sample size) and rounding up.
For example, the pattern {1, 3, 4} will be rescaled to {0.125, 0.375, 0.5}. The group sample sizes will be
constrained to these proportions (within rounding) during the search for the sample configuration that just meets
the power requirement.
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Incomplete List
If the number of items in the list is less than G, the missing numbers are set equal to the last entry in the list.
Range
The items in the list must be positive. The resulting sample sizes must be at least 1.
Columns of Group Allocation Patterns
Enter one or more spreadsheet columns containing vertical lists of group allocation patterns.
Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.
Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the group allocation patterns are entered going down.
Examples (assuming G = 3)
C1
C2
C3
1
1
3
1
2
3
3
2
1
Definition of a Single Column
Each column gives one allocation pattern. Each column results in a new scenario. The columns are not connected,
but all should have exactly G rows.
Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry in the list before
they are rescaled.
Valid Entries
All values should be positive numbers. You can enter decimal values.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet

Effect Size - μ1, μ2, ..., μG (Group Means)
𝛍𝛍i’s Input Type
Specify how you want to enter 𝜇𝜇1, 𝜇𝜇2, … , 𝜇𝜇𝜇𝜇, the means for each of the G groups.
Options

•

𝛍𝛍𝛍𝛍, 𝛍𝛍𝛍𝛍, … , 𝛍𝛍𝛍𝛍
Specify the values of the means for each group. The differences among these values represent the effect size
that you want to detect.

•

Columns Containing Sets of 𝛍𝛍𝛍𝛍′𝐬𝐬
Select one or more columns of the spreadsheet that each contain a set of 𝜇𝜇𝜇𝜇′𝑠𝑠 going down the column. Each
column is analyzed separately.

549-6
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Multiple Poisson Rates in a One-Way Design

𝛍𝛍𝛍𝛍, 𝛍𝛍𝛍𝛍, … , 𝛍𝛍𝛍𝛍
Enter the values of the means, one for each of the G groups. These entries provide values assumed by the
alternative hypothesis. The null hypothesis assumes that all of the values are equal. The effect size detected by the
study is a function of the differences among these values.
This value is the anticipated mean of all subjects in a particular group.
Range
Each 𝜇𝜇𝜇𝜇 can be any positive number. Also, at least one of the values must be different from the rest.

Example
0.2 0.1 0.1 0.1

Incomplete List
If the number of items in a list is less than G, the missing numbers are set equal to the last entry.
Columns Containing Sets of 𝛍𝛍i’s
Enter one or more spreadsheet columns containing vertical lists of μ1, μ2, ..., μG.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can
obtain the spreadsheet by selecting “Tools”, then “Input Spreadsheet”, from the menus.
On the spreadsheet, the μi's are entered going down.
Examples (assuming G = 3)
C1
C2
C3
0.5
0.5
0.5
0.1
0.2
0.3
0.1
0.3
0.4
Definition of a Single Column
Each column gives one set of probabilities. Each column results in a new scenario. The columns are not
connected, but all should have exactly G rows.
Incomplete List
If the number of items in a column is less than G, the missing numbers are set equal to the last entry in the
column.
Valid Entries
Positive numbers.
Note
The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.
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Example 1 – Determining Power
Researchers are planning a study comparing three medications: a standard drug and two experimental drugs. The
experimental drugs are expected to have about the same impact on response rate. The outcome is a count—a nonnegative integer value.
Each subject will receive an application of only one drug. The response is a count variable. With the standard
drug, this response has been about 3.4. The researchers want a sample size large enough to detect a difference of
0.6 in the response rate. They will use the means of 3.4, 2.8, and 2.8 to represent this difference.
The test will be conducted at the 0.05 significance level. The subjects will be randomly split equally among the
three groups.
What powers are achieved by group sample sizes between 100 and 200?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Ni (Subjects Per Group) ......................... 100 120 140 160 180 200
μi's Input Type ........................................ μ1, μ2, ..., μG
μ1, μ2, ..., μG .......................................... 3.4 2.8 2.8

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3

Power
0.7082
0.7898
0.8517
0.8973
0.9300
0.9529

Total
Subjects
Count
N
300
360
420
480
540
600

Subjects
Per
Group
Ni
100
120
140
160
180
200

Group
Means
Set
μi
μi(1)
μi(1)
μi(1)
μi(1)
μi(1)
μi(1)

Effect
Size
Cramer's
V
0.1143
0.1143
0.1143
0.1143
0.1143
0.1143

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Set(Set Number): Values
Pi(1): 3.4, 2.8, 2.8
References
Y. Mai and Z.Zhang. 2017. Statistical power analysis for comparing means with binary or count data based on
analogous ANOVA. In L. A. van der Ark, M. Wiberg, S. A. Culpepper, J. A. Douglas, & W.-C. Wang (Eds.),
Quantitative Psychology - The 81st Annual Meeting of the Psychometric Society, Asheville, North Carolina,
2016: Springer.
Z. Zhang and K.H. Yuan. 2018. Practical Statistical Power Analysis: Using WebPower and R. ISDSA Press.
Granger, IN.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Subject Count N is the total number of subjects in the study.
Subjects Per Group Ni is the number of subjects per group.
Group Means Set μi gives the name and number of the set containing the mean responses for each group.
Effect Size Cramer's V is a measure of the effect size. It is the association between the outcome variable and the
grouping variable. It is the proportion of the maximum variation in the outcome variable accounted for by the
grouping variable.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is
true.
Summary Statements ─────────────────────────────────────────────────────────
A sample of 300 subjects, divided among 3 groups, achieves a power of 0.7082. This power assumes a
chi-squared test from an analysis with 2 degrees of freedom is used at a significance level of 0.050. The group
subject counts are 100, 100, 100. The group means under the alternative hypothesis are 3.40, 2.80, 2.80. The
effect size is 0.1143.

This report gives the sample size for each value of the other parameters.

This shows the relationship among the design parameters.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to determine the sample size corresponding to powers of 0.8 and
0.9.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8 0.9
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
μi's Input Type ........................................ μ1, μ2, ..., μG
μ1, μ2, ..., μG .......................................... 3.4 2.8 2.8

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3

Power
0.8003
0.9011

Total
Subjects
Count
N
369
486

Group
Subject
Alloc
Set
ri
ri(1)
ri(1)

Group
Means
Set
μi
μi(1)
μi(1)

Effect
Size
Cramer's
V
0.1143
0.1143

Alpha
0.050
0.050

Set(Set Number): Values
ri(1): 0.333, 0.333, 0.333
μi(1): 3.40, 2.80, 2.80

The sample sizes are 369 for a power of 0.8 and 486 for a power of 0.9. Note that the search routine only searches
designs that have equal group sizes (i.e. that are divisible by 3 since there are 3 groups).
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Example 3 – Comparing Various Effect Sizes
Continuing with Examples 1 and 2, the researchers want to compare the sample size of various sets of group
means. To do this, they will compare the four sets of means shown in the following table. The first row is the
mean for the standard medication. The second and third rows give the anticipated means of the experimental
medications.
The values in this table must be loaded into the spreadsheet.
Table of Four Sets of Response Probabilities
C1

C2

C3

C4

3.4
2.8
2.8

3.4
3.0
3.0

3.4
3.1
3.1

3.4
2.8
3.1

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.9
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 3
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
μi's Input Type ........................................ Columns containing sets of μi's
Columns Containing Sets of μi's ............. C1-C4
The above table must be entered into the spreadsheet and the column names changed to C1 – C4.
Press the Input Spreadsheet icon to the right to view the spreadsheet.

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 3
Group
Total
Subject
Group
Effect
Subjects
Alloc
Means
Size
Count
Set
Set
Cramer's
Power
N
ri
μi
V
Alpha
0.9011
486
ri(1)
C1(1)
0.1143
0.050
0.9002
1131
ri(1)
C2(2)
0.0748
0.050
0.9002
2046
ri(1)
C3(3)
0.0556
0.050
0.9006
654
ri(1)
C4(4)
0.0985
0.050
Set(Set Number): Values
ri(1): 0.333, 0.333, 0.333
C1(1): 3.40, 2.80, 2.80
C2(2): 3.40, 3.00, 3.00
C3(3): 3.40, 3.10, 3.10
C4(4): 3.40, 2.80, 3.10
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Note that the horizontal axis gives the index of the mean set footnote. Thus, ‘1.0’ is column C1(1), ‘2.0’ is column
C2(2), and so on.
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Example 4 – Validation of Power Calculation using Zhang and
Yuan (2018)
Zhang and Yuan (2018) page 127-128 present an example in which G = 4, α = 0.05, and Ni = 25.
Their example provides the individual group means as μ1 = 3.48, μ2 = 4.24, μ3 = 3.12, and μ4 = 3.00. These
result in a V of 0.148, so we will use these values in the validation.
Zhang and Yuan (2018) do not complete the power calculation, so we will do this using PASS’s Probability
Calculator. We find that the critical value of C = 7.814728 and that the noncentrality parameter is
100(3)(0.148)(0.148) = 6.5712. This results in a power of 0.5594 using the noncentral chi-squared calculator.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
G (Number of Groups) ............................ 4
Group Allocation Input Type ................... Equal (N1 = N2 = ··· = NG)
Ni (Subjects Per Group) ......................... 25
μi's Input Type ........................................ μ1, μ2, ..., μG
μ1, μ2, ..., μG .......................................... 3.48 4.24 3.12 3.00

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Number of Groups: 4

Power
0.5594

Total
Subjects
Count
N
100

Subjects
Per
Group
Ni
25

Group
Means
Set
μi
μi(1)

Effect
Size
Cramer's
V
0.1480

Alpha
0.050

Set(Set Number): Values
μi(1): 3.48, 4.24, 3.12, 3.00

The power of 0.5594 matches the calculated power exactly, so the procedure is validated. The value of V of 0.148
matches the value from Zhang and Yuan (2018).
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